Guidance on different ways to analyse SIMD
(Updated March 2013)
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1. Aims
Analysis of the SIMD often focuses on the 15% most deprived datazones in Scotland. However there are alternative ways of analysing the SIMD. This guidance paper provides worked examples of some of the other ways in which the SIMD can be used.
The paper was initially written to provide users in rural areas with examples of forms of analysis that did not focus solely on the 15% most deprived datazones in Scotland. However as the paper progressed it became clear that the same types of analysis would be useful for users across the whole of Scotland. So, while the examples often refer to rural local authorities and may be especially useful in rural areas, the paper is aimed at anyone who is looking to perform analysis using the SIMD.
2. Background

The Scottish Index of Multiple Deprivation (SIMD) identifies small area concentrations of multiple deprivation across all of Scotland in a consistent way. 
It does this by providing a ranking for each of the 6,505 small areas (called datazones) that make up the whole of Scotland. The datazones are ranked from most deprived (1) to least deprived (6,505). The ranking is based on 7 aspects of deprivation – Income, Employment, Health, Education, Access to services, Crime, and Housing.
Since the ranking itself does not provide any way of identifying areas that are “deprived” versus “not deprived”, analysis of the SIMD requires the user to apply a cut-off to identify the most deprived areas. A frequently used cut-off is 15%: i.e., analysis of the SIMD focuses on the 15% most deprived datazones in Scotland, which means datazones with a rank of 976 or less. 
For many purposes this focus on the 15% most deprived is appropriate. However for other purposes (e.g. analysis of rural parts of Scotland) a different focus is often necessary and it’s important to realise that the SIMD can be used to do much more than simply identify the 15% most deprived areas.
This paper outlines a number of different ways in which the SIMD can be used to say something about deprivation in a chosen area. Worked examples are used throughout and, for those who want detailed instructions, a series of ‘How do I do that?’ boxes are provided. More experienced users of SIMD may wish to ignore these boxes.
We would welcome any feedback on this paper. In particular, if there are any other forms of analysis using SIMD you would like to see covered then please let us know by contacting us.
3. Analysis options
This section explains a number of the options available for analysing the SIMD. 
	Analysis options considered in this section

1) Identifying the most deprived datazones in an area (Section 3.1)
There are a number of ways of doing this:

1) Identify the most deprived datazone in an area

2) Choose a cut-off other than 15% to identify which of the most deprived datazones across Scotland fall in an area

3) Don’t use a national cut-off but instead use a local one (e.g. look at the 20% most deprived datazones within Orkney)

2) Concentrate on particular domains (Section 3.2)
The SIMD is built up from 7 domains. Looking at these can tell us more about the nature of deprivation in an area. 

1) Looking at the individual domains can help to explain an area’s overall SIMD rank. 

2) The income and employment domains can be used to tell us how many people in an area are income and employment deprived.

3) Some domains may be more relevant than others for your purposes. For example, the income, employment and access domains may be especially relevant in rural areas.

3) Analysis using maps (Section 3.3)
Using maps can be a good way of looking at the SIMD results for an area or for identifying deprived areas. They may also highlight patterns which wouldn’t be apparent if we just look at tables of data.
4) Analysis using box plots (Section 3.4)
Box plots are a good way of looking at SIMD ranks as they summarise the distribution of all datazone ranks in an area. 

5) Analysis using bar code charts (Section 3.5)
Bar code charts are another way of looking at the SIMD ranks for an area. They provide an ‘at a glance’ view of the distribution of datazone ranks.
6) Analysis using bar charts (Section 3.6)
Bar charts can also be used to summarise the distribution of an area’s datazones. 
7) Analysis using indicators (Section 3.7)
It can be useful to look at the individual indicators which make up the SIMD domains as these can give an insight into the reason for an area’s overall SIMD rank or its domain rank.
8) Scottish Neighbourhood Statistics (SNS) (Section 3.8)
The SNS website provides a wider range of small area data than that used in the SIMD and can provide more contextual data about an area.


The best analysis option for you will depend on what sort of analysis you want to perform and on the type of area you’re interested in. 
The guidance and examples used in this chapter generally refer to local authorities for simplicity. However the same sort of analysis can be performed for other types of area, e.g., Health Boards, Scottish Parliamentary Constituencies, etc.
3.1. Identifying the most deprived datazones in an area

Although analysis of the SIMD often focuses on the 15% most deprived datazones in Scotland, sometimes it makes sense to look at datazones outwith the 15% most deprived. This might be the case for local authorities which have no datazones in the category of Scotland’s 15% most deprived.
3.1.1. Identify the single most deprived datazone in an area
The first analysis option outlined here is to identify the single most deprived datazone in an area.

For example, Eilean Siar has 0 datazones in the 15% most deprived. However, we can use either the published SIMD 2012 data or the SIMD interactive mapping in order to establish that datazone S01002364 is the most deprived in Eilean Siar in SIMD 2012 (its rank is 1,692).

· SIMD 2012 data: http://simd.scotland.gov.uk/publication-2012/download-simd-2012-data/
· SIMD interactive mapping: http://www.sns.gov.uk/Simd/

This may mean that Eilean Siar want to focus on this specific datazone and determine why it is relatively more deprived than others in the local authority. 
	How do I do that?

Background data
· Open the SIMD background data spreadsheet (Part 2) found here: http://www.scotland.gov.uk/Topics/Statistics/SIMD/DataAnalysis/Background-Data-2012/Background2SIMD2012
· Sort the datazones by SIMD rank:

· Either Select Sort from the Data menu then choose ‘Overall SIMD 2012 Rank’ from the dropdown list and click ok 
· Or Click somewhere in the column called ‘Overall SIMD 2012 Rank’ then click on the ‘Sort ascending’ button [image: image1.png]



· Select Eilean Siar datazones:

· Click on cell C1, go to the Data menu and select Filter -> AutoFilter 

· Choose Eilean Siar (by clicking on the dropdown arrow in cell C1)

· The top datazone will now be the most deprived in Eilean Siar.

Interactive mapping
· Open the interactive mapping found here: http://www.sns.gov.uk/Simd/ 

· Scroll down to below the map to view the list of local authorities, and select Eilean Siar from the list 

· This will display Eilean Siar’s datazones, sorted by descending SIMD 2012 rank

· The top datazone will be the most deprived in Eilean Siar.


3.1.2. Select a higher cut-off
It is not always appropriate to focus solely on the single most deprived datazone in an area. Another option is to select a higher cut-off than the usual 15%, and to identify all datazones falling below this. For example, a cut-off of 20% or 30% may be more appropriate for some local authorities. 

· To identify the datazones which fall into the 20% most deprived in Scotland, we calculate that 20% of the 6,505 datazones is 1,301. This means that all datazones with an overall rank of 1,301 or less fall within the category of the 20% most deprived in Scotland. 

· 30% most deprived in Scotland, we calculate that 30% of the 6,505 datazones is 1,952. This means that all datazones with an overall rank of 1,952 or less fall within the category of the 30% most deprived in Scotland. 
A lookup showing classifications for numerous cut-offs is available from:

http://www.scotland.gov.uk/Topics/Statistics/SIMD/simdbackgrounddataannexb.
Again using either the background data or the interactive mapping, we can apply this to (for example) Moray local authority. This shows that there are nine datazones in Moray which fall into the category of 30% most deprived in Scotland in SIMD 2012. These are the datazones with ranks from 1,221 (datazone S01004303) to 1,948 (datazone S01004276). See screenshot below.
Screenshot from interactive mapping website – most deprived datazones in Moray 
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Local authorities may choose to focus on datazones falling below this (or another) cut-off. Table 1 shows, for the local authorities which have less than 10 datazones in the 15% most deprived, the number of datazones they have in the 20% and the 30% most deprived . Both Orkney Islands and Shetland Islands do not have any datazones in the 30% most deprived. Another cut-off would have to be used in these local authorities or, alternatively, another method of analysis (see, e.g., section 3.2.3 below).
Table 1: Local authorities which have less than 10 datazones in the 15% most deprived in Scotland, SIMD 2012
	Local Authority
	Number of datazones in local authority
	Number of datazones in the 15% most deprived
	Number of datazones in the 20% most deprived
	Number of datazones in the 30% most deprived

	Aberdeenshire
	301
	5
	5
	12

	Angus
	142
	3
	9
	24

	East Dunbartonshire
	127
	3
	4
	12

	East Lothian
	120
	3
	6
	19

	East Renfrewshire
	120
	7
	9
	11

	Eilean Siar
	36
	0
	0
	1

	Midlothian
	112
	3
	8
	24

	Moray
	116
	0
	2
	9

	Orkney Islands
	27
	0
	0
	0

	Perth & Kinross
	175
	6
	11
	18

	Scottish Borders
	130
	5
	7
	15

	Shetland Islands
	30
	0
	0
	0

	Stirling
	110
	7
	11
	23


3.1.3. Identify the locally most deprived datazones
The method outlined in section 3.1.2 above involved determining how many datazones in an area fell below some cut-off which applied to the whole of Scotland. An alternative is to apply a cut-off just to datazones within a local authority.
So, you might choose to identify and focus on the 20% or 30% locally most deprived datazones within your local authority. This is effectively using the SIMD ranks to create a local version of the SIMD.

For example, you might want to focus on the 20% most deprived datazones in the Orkney Islands. 
	How do I do that?

· Open the SIMD data spreadsheet:
http://www.scotland.gov.uk/Topics/Statistics/SIMD/DataAnalysis/Background-Data-2012/Background2SIMD2012
· Select the datazones in Orkney Islands:

· Click on cell C1 (the column headed ‘Local Authority Name’) and from the Data menu select Filter -> AutoFilter
· Choose Orkney Islands (by clicking on the dropdown arrow in cell C1)

· Copy and paste this selection onto a new sheet

· Sort these datazones by SIMD rank:

· Either Select Sort from the Data menu then choose ‘Overall SIMD 2012 Rank’ from the dropdown list and click ok 
· Or Click somewhere in the ‘Overall SIMD 2012 Rank’ column then click on the ‘Sort ascending’ button [image: image3.png]


 
· Count the number of datazones in the list (27 for Orkney)

· Work out what 20% of this number is (20% of 27 is 5.4, or 5 rounded to the nearest whole number)

· Select the appropriate number of datazones from the top of the list (5 in this example)


Table 2 below shows the datazones which are selected for the Orkney Islands using this method.

Table 2: Datazones in Orkney Islands 
[image: image4.emf]Datazone Intermediate Geography name
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S01004958West Kirkwall 2,253 1y

S01004969Isles 2,320 2y

S01004959West Kirkwall 2,472 3y

S01004954East Kirkwall 2,553 4y

S01004971Isles 2,589 5y

S01004970Isles 2,893 6n

S01004968Isles 3,032 7n

S01004972Isles 3,215 8n

S01004953West Kirkwall 3,396 9n

S01004955East Kirkwall 3,417 10n

S01004951Stromness, Sandwick and Stenness 3,974 11n

S01004967West Mainland 4,134 12n

S01004965West Mainland 4,142 13n

S01004963West Mainland 4,207 14n

S01004947East Mainland 4,266 15n

S01004949West Mainland 4,334 16n

S01004956Stromness, Sandwick and Stenness 4,414 17n

S01004961East Kirkwall 4,434 18n

S01004950East Mainland 4,492 19n

S01004966West Mainland 4,636 20n

S01004946East Mainland 4,709 21n

S01004948Stromness, Sandwick and Stenness 4,796 22n

S01004964Stromness, Sandwick and Stenness 4,911 23n

S01004952West Kirkwall 4,987 24n

S01004960East Kirkwall 5,035 25n

S01004957East Mainland 5,072 26n

S01004962East Mainland 5,510 27n


3.2. Concentrating on particular domains
The overall SIMD rank of a datazone is based on its rank in 7 different aspects of deprivation – the income, employment, health, education, access to services, crime, and housing domains. 

For each of the analysis options outlined in section 3.1 above you may want further information on why these particular datazones are ranked more deprived than others. One way of looking into this is to investigate individual SIMD domains. Performing analysis on individual SIMD domains can also be a useful analysis option in its own right.

3.2.1. Getting more information using domains
In section 3.1.1 above, we found that datazone S01002364 is the most deprived in Eilean Siar, with a rank of 1,692. We might wonder why this datazone is relatively deprived according to SIMD. 

One simple way to get more information on this is to look at the datazone’s rank for each of the individual domains. 
	How do I do that?

Background data
· Open the SIMD background data spreadsheet (Part 2) found here: http://simd.scotland.gov.uk/publication-2012/download-simd-2012-data/
· Scroll down until you find the row containing datazone S01002364

· Scroll along to the right to see the ranks for each of the SIMD domains

Interactive mapping
· Open the interactive mapping found here: http://www.sns.gov.uk/Simd/Simd.aspx 

· Type the datazone code (S01002364) into the search box and click ‘Go’
· Scroll down to the tabs below the map and click on the ‘Domain Ranks’ tab


Screenshot from interactive mapping website – domain ranks for datazone S01002364 
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From the Domain Ranks tab we can see that datazone S01002364 has low ranks for three domains, Crime (in the 15% most deprived in Scotland), and Health and Access (in the 20% most deprived in Scotland). This suggests that we might want to focus our attention on these aspects of deprivation. To do this, it will be helpful to look at the individual indicators which make up each domain (see section 3.8 below).
3.2.2. Looking at the proportion of the population who are income or employment deprived
The income and employment domains are considered to be the most important factors when identifying concentrations of multiple deprivation and so have the largest weightings in the SIMD. They are also based on counts of deprived people, unlike in most other domains, which means that they allow us to identify the number of people in an area who are deprived. These two domains are updated annually and the type of analysis outlined below can be performed using these annual updates. It is also possible to compare these domains over time (although care must be taken, as changes have been made to the income domain between the various updates to the SIMD).
While it is not possible to add up or average ranks across datazones to get a rank for a larger area, we can add up the number of people who are income deprived or employment deprived across datazones. 
In section 3.1.3 we identified the 20% locally most deprived datazones in Orkney. Having done so we might want to compare the level of employment deprivation in these areas with that in the rest of the local authority.
Using the SIMD 2012 background information (http://simd.scotland.gov.uk/publication-2012/download-simd-2012-data/) for the 20% locally most deprived datazones in the Orkney Islands, we find that 11% of the working age population are employment deprived, compared to 6% in the rest of the local authority.

	How do I do that?

· Open the Employment domain background data spreadsheet (Part 4): http://simd.scotland.gov.uk/publication-2012/download-simd-2012-data/ 
· Select Orkney Islands datazones:

· Click on cell B1 (the column headed ‘Local Authority Code’) and from the Data menu select Filter -> AutoFilter 

· Choose Local Authority Code ‘330’ for Orkney (by clicking on the dropdown arrow in cell B1) (a full list of local authority codes and names can be found here: http://www.scotland.gov.uk/Topics/Statistics/sns/SNSRef/CodeNameMar2011) 

· Copy and paste this selection into a new worksheet

· For each of the datazones identify whether it is amongst the 20% locally most deprived in Orkney (see section 3.1.3 above for details of how to do this). It might be easiest to add a new column and keep track of this by entering ‘Y’ or ‘N’; see Table 3 below.
· Find the following values (labelled on Table 3 below):

· (A) – the number of employment deprived people in the 20% locally most deprived datazones (from the column titled ‘Number of Employment Deprived People 2012’)
· (B) – the working age population in the 20% locally most deprived datazones (from the column titled ‘Best-fit Working Age Population’) 
· (C) – the number of employment deprived people outwith the 20% locally most deprived datazones (from the column titled ‘Number of Employment Deprived People 2012’)
· (D) – the working age population outwith the 20% locally most deprived datazones (from the column titled ‘Best-fit Working Age Population’)

· Calculate the percentage of the working age population in the 20% locally most deprived datazones who are employment deprived 
· = (A) divided by (B)
· Calculate the percentage of the working age population outwith the 20% locally most deprived datazones who are employment deprived 
· = (C) divided by (D)


Table 3: Comparing the 20% most deprived in Orkney with the 80% least deprived in Orkney
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3.2.3. Identifying the most income, employment, and access deprived rural areas
As well as looking at individual domains of the SIMD it is possible to select a few relevant ones and look at them together. 

For SIMD 2009 the Scottish Government published a paper which did this for rural areas by identifying the most deprived rural datazones on one or more of the income, employment and access domains:

http://www.scotland.gov.uk/Topics/Statistics/SIMD/deprivedruralpaper
The paper contains a series of maps identifying the most deprived 20% of rural datazones in Scotland for each combination of domains. 
An interactive spreadsheet which provides more detail for individual local authorities was also produced:

http://www.scotland.gov.uk/Topics/Statistics/SIMD/deprivedruralspreadsheet
3.3. Analysis using maps
Maps can offer a useful way of looking at SIMD results for an area. At the simplest level they can allow you to work out where a datazone actually is. This is especially important given that datazones have relatively meaningless codes such as S01000001.
	How do I do that?
· You can use the SIMD interactive mapping to find a datazone along with basic SIMD information on that datazone:
http://www.sns.gov.uk/Simd/


Maps can also highlight areas identified as being deprived by the SIMD or by its individual domains. The simplest option for using maps in this way is again to use the SIMD interactive mapping (http://www.sns.gov.uk/Simd/).
For example, we may be interested in South Ayrshire and so use the SIMD interactive mapping to highlight deprived areas. We may then want to look into how this pattern of deprivation compares to that for the individual domains we are interested in (e.g. Education).
	How do I do that?
· The interactive mapping website can be found here: http://www.sns.gov.uk/Simd/Simd.aspx. 

· You can see a map for an area of interest either by selecting a local authority, Scottish Parliamentary Constituency or Health Board (from the list below the map) or by entering a postcode, datazone code or place name into the search box at the bottom of the map.

· By default the map will display 5 different categories – the 5% most deprived, 5-10%, 10-15%, 15-20% and 20-100%. You can change this using the ‘Classification’ dropdown box to the top right of the screen (e.g., try selecting quintiles – this shows 20% bands).

· Similarly you can focus on a domain of interest (e.g. education) by choosing from the ‘Domain’ dropdown box.

· You can also look at different versions of SIMD (i.e. SIMD 2012, SIMD 2009, SIMD 2006 or SIMD 2004) using the ‘SIMD Year’ dropdown box.


If we are interested in South Ayrshire, we can see that, for example, datazone S01005524 to the east of Girvan is in the 20-40% band on the overall SIMD but in the 40-60% band in the education domain.
Screenshots from interactive mapping website, demonstrating how a datazone’s quintile changes depending on whether you look at its overall SIMD rank or its rank on a specific domain such as Education 

[image: image7.png]C00 (B ntwiftwmm . govsisimdsind aspx

(] [x]

Fle Edt View Favortes Took Help

& & [ [Crome 2. owroad 510 2. |Ki(sacoround ot | 8 ot Neitbe... |Kiincame,enloym...{Z¢income, enplym...| @ ot el .. <

o page - 0 Took -

Home > Scotish Index of Multiple Deprivation

St ionof e Deprvation SIMA s e
o et e e T st s yuts i rciv e f o I o s 8 of Seposfow e
e e St o e, TSIl o 0 Ve ST s e SO st o e f et Youcn v
IS fr o rral SO 3 o el s ke e SHO (reo, et et o b s ).
ompeneos o e bt

Scotland > South Ayrshire > Carrick South > 501005524

Swoyear Eh 3
oomsin D
Cossitaton [ cuios F
P F
N 3
Gt

[—

Dintermediate Geographies

2011 scottish Pariamentary Constituencies

O Heatth Boards.

L 1

Wowow  Eoowcson [ak<com
eow-<s0% ek 100%

Intermediate Geography- Carrick South
Local Authority: South Ayrshire





[image: image8.png]C00 (B ntwiftwmm . govsisimdsind aspx

(] [x]

Fle Edt View Favortes Took Help

* & [38]-[Crome 2. owroad 510 2. |Ki(sacoround ot | 8 ot Neitbe... |Kiincame,enloym...{Z¢income, enplym...| @ ot el .. <

o page - 0 Took -

Home > Scotish Index of Multiple Deprivation

Scottish Index of Muitiple Deprivation

SIMD 2012 Publication Web Portal.

Scotland > Soll(h Ayrshire > Carrick South > 501005524

Intermediate Geography- Carrick South
Local Authority: South Ayrshire

SIMA s e

Welcome to the SIMD interactive mapping website. This website allows you to view interactive maps of the SIMD results for any area of Scotland. You can view
resuts for the overall SIMD or resuts for the individual domains that make up the SIMD (income, employment, health, education, housing, access, and crime).
Comparisons can be made between the current SIMD and previous SIMDs. To find out more about the SIMD and view the full SIMD 2012 results, please visit the
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If the interactive mapping doesn’t provide you with what you need, then, depending on your requirements, we may be able to help, or you may have mapping software of your own which could be used to map SIMD data. (Guidance on this is beyond the scope of this paper).
3.4. Analysis using boxplots
As mentioned above, it is often useful to look beyond the 15% most deprived datazones. One way of doing this, as described in Section 3.2, is to apply different cut-offs. An alternative is to use boxplots to look at the distribution of all datazones in an area.
Details of how to interpret boxplots are provided at: 
http://www.scotland.gov.uk/Publications/2009/10/28104046/12 
(part of the SIMD 2009 General Report). 

Boxplots can be used to look at the distribution of an area’s datazones across the SIMD, across domains and even across individual indicators within a domain. It is possible to identify the position of individual datazones on these charts, something which can be especially useful if you want to understand what is contributing to an area’s SIMD rank or domain rank.
For example, let’s say we are interested in the distribution of Dumfries & Galloway’s datazones across all domains.
We can produce a boxplot to show the distribution of Dumfries & Galloway’s datazones. A spreadsheet has been produced to do this for you (details below). The spreadsheet also allows us to highlight a chosen datazone on the chart and to select a local authority to compare to if we wish. To show how this works we’ll choose datazone S01000963 and compare Dumfries & Galloway with Scottish Borders.

	How do I do that?
A number of spreadsheets have been created to allow you to automatically produce boxplots: 
www.scotland.gov.uk/Topics/Statistics/SIMD/SIMDAnalysis
Some of these produce boxplots at domain level and others at indicator level. In this case we will use the domain level spreadsheet. (The indicator level spreadsheet is used to produce the chart in section 3.8, below.)
To summarise the instructions provided in the spreadsheet,
· Select ‘Dumfries & Galloway’ from the first dropdown list.

· Select the datazone of interest (S01000963) from the second dropdown list. You can leave this blank if you don’t want to highlight a particular datazone.

· Select ‘Scottish Borders’ from the third dropdown list. You can leave this blank if you don’t want to compare with another area.


Screenshot of automatically generated boxplot comparing Dumfries & Galloway with Scottish Borders and highlighting a specific datazone of interest
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This boxplot shows, for example, that datazones in Dumfries & Galloway tend to have worse ranks for geographic access than for other domains.

Comparing with Scottish Borders we can see that the distributions of the two local authorities are quite similar but there are some differences. For example, in the income domain, 25% of Dumfries & Galloway’s datazones have a rank of about 2,500 or less, whereas the same proportion of Scottish Borders’ datazones have a rank of about 3,000 or less.
We can also see that S01000963 is amongst the 25% most deprived datazones overall in Dumfries & Galloway but is amongst the 25% least deprived in the Health domain.
3.5. Analysis using barcode charts
Another type of chart which can also be used to look at the distribution of datazones in an area is barcode charts.
Each bar in a barcode chart represents a single datazone placed on a scale from most deprived to least deprived according to SIMD rank. Concentrations of datazones with similar ranks show up as dark blocks.
For example, let’s say we are interested in the distribution of Highland’s datazones.

We can produce a barcode chart to show the distribution of Highland’s datazones. A spreadsheet has been produced to do this for you (details below). The spreadsheet also allows us to highlight a chosen datazone on the chart. To show how this works we’ll choose datazone S01003862.

	How do I do that?
A spreadsheet has been created to allow you to automatically produce barcode charts: 
www.scotland.gov.uk/Topics/Statistics/SIMD/SIMDAnalysis. 

To summarise the instructions within the spreadsheet:

· Select ‘Highland’ from the first dropdown list.
· If you wish to highlight a particular datazone, type the datazone code (S01003862) into the box in the ‘Highlight a datazone’ section (you can leave this blank if you don’t want to highlight a particular datazone).


Barcode chart for Highland
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We can see from the barcode chart that a lot of the datazones in Highland are clustered near the middle of the SIMD scale although there are also some near the most deprived end and some near the least deprived end. Datazone S01003862 (highlighted in red) can be seen to be one of the most deprived in the local authority.
3.6. Analysis using bar charts
Another way of looking at the distribution of datazones across an entire local authority is to use bar charts. These are relatively simple charts which can show us the distribution of an area’s datazones across, for example, quintiles, deciles or vigintiles. They can also be used to show the ranks and domain ranks of a group of datazones.
	Quintiles, deciles and vigintiles
The SIMD ranks Scotland’s 6,505 datazones from 1 = most deprived to 6,505 = least deprived. Sometimes it’s useful to summarise these into a smaller number of groups. This is what quintiles, deciles and vigintiles allow us to do.

Quintiles split up Scotland’s datazones into 5 groups, each containing 20% of Scotland’s datazones. The first quintile contains the 20% most deprived datazones, quintile 2 contains the next 20% most deprived, etc.

Deciles split Scotland’s datazones into 10 groups, each containing 10% of Scotland’s datazones. The first decile contains the 10% most deprived datazones, decile 2 contains the next 10% most deprived, etc.

Vigintiles split Scotland’s datazones into 20 groups, each containing 5% of Scotland’s datazones. References to the 15% most deprived datazones are therefore equivalent to vigintiles 1 to 3.


Examples of bar charts showing the distribution of datazones across deciles for each local authority were published as part of SIMD 2012. These can be found here:
http://simd.scotland.gov.uk/publication-2012/local-authority-summaries-simd-2012/
Bar charts can also be a good way to show the domain ranks for individual datazones. For example, let’s say we’re interested in Eyemouth in Scottish Borders. We can use a bar chart to show the domain ranks for the datazones which comprise the Eyemouth intermediate geography.
	How do I do that?

First we need to identify the datazones in the intermediate geography of Eyemouth. 
To do this, open the datazone lookup tool from the SIMD website:
http://simd.scotland.gov.uk/publication-2012/download-simd-2012-data/
· Click on the ‘Quick Lookup’ tab.

· Filter the data by the Local Authority Name column (cell I2) to select the local authority of interest (Scottish Borders)

· Then filter the data by the Intermediate Geography column (cell C2) and select the Intermediate Geography of interest (Scottish Borders – Eyemouth) (this should give 4 datazones)
· Highlight the rows (including the column headings) then copy and paste this into a new sheet.

Next we want to create a bar chart for these datazones. 
The following instructions apply to Microsoft Excel 2003.

· In the new sheet you’ve just created, delete the irrelevant columns so that you’re left with a column for the datazone, the overall SIMD rank, and the individual SIMD domain ranks.
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· Highlight this data.
· From the ‘Insert’ menu select ‘Chart’

· On the chart wizard select ‘Next’, then in the next step change the ‘series in’ selection from ‘rows’ to ‘columns’ and click ‘Next’ again.

· In the next step you can add labels and a title and, by clicking on the ‘Legend’ tab you can change the position in which the legend appears.
· Finally select ‘Finish’.
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From the bar chart we can see, for example, that datazones S01005486 and S01005487 have lower crime ranks (i.e., are more crime-deprived) than the other two Eyemouth datazones. 
This type of chart can be a good way to find groups of datazones all suffering from a particular type of deprivation, especially when their overall SIMD rank does not identify them as deprived.
3.7. Analysis using indicators
As shown in section 3.2, we can look at a datazone’s ranking on individual domains to help us better understand its overall SIMD ranking. However we may then want more information on what is contributing to the domain rank. It is possible to analyse data on the individual indicators used within SIMD. These can help to explain why a particular datazone has a particular SIMD or domain rank. 
As far as possible all the data used in the SIMD has been published on the SIMD website (for example, here: 
http://www.scotland.gov.uk/Topics/Statistics/SIMD/DataAnalysis/Background-Data-2012/Background2SIMD2012)

and on the Scottish Neighbourhood Statistics (SNS) website (www.sns.gov.uk). 
In some cases it has not been possible to publish the data exactly as it was used in SIMD. For example, some indicators have not been published at all and others have been ‘disclosure controlled’. This is because our data suppliers have decided that releasing the data as it was used in SIMD could breach confidentiality rules. However, in most cases the data, or a disclosure-controlled version of the data, has been published and so can be used for further analysis.
For example, we can look at the Access domain. 

Datazone S01004314 in Moray is ranked 810 in the Access domain. A quick look at the background data shows that it has a higher rank for the Drive Time sub-domain (rank 1,002) than in the Public Transport sub-domain (rank 653). This might suggest that the low Access rank for this datazone is mainly due to public transport in this area. We can look at the background data to see what’s going on.
	How do I do that?

Open the Geographic Access domain background data spreadsheet (Part 8) found here:
http://www.scotland.gov.uk/Topics/Statistics/SIMD/DataAnalysis/Background-Data-2012/Background8Access2012
Scroll down until you find the datazone you’re interested in (datazone S01004314 in this example)
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From the spreadsheet we can see that this datazone actually has reasonably short drive times to most services (less than 7 minutes to GP, petrol station, post office, primary school and secondary school, and retail centre). However it has a much larger public transport travel time to GP, post office, and retail centre (over 17 minutes). 
This might suggest that there is a lack of nearby shopping facilities to this datazone and that this is what is causing the relatively low rank in the domain. Just looking at these numbers on their own doesn’t tell us whether these are especially long drive and public transport times to shopping facilities. We might want to use a boxplot to see how this datazone compares to the rest of the local authority. 
Boxplot showing Access indicators for Moray
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Using a boxplot to show the indicators (see section 3.4 above for a link to a spreadsheet which will generate this boxplot for you) we can see that for datazone S01004314, drive times to GP, petrol station, and post office were relatively high. 
3.8. Scottish Neighbourhood Statistics (SNS)
The SIMD allows us to identify deprived areas in Scotland. Using the domain and indicator data we can begin to understand why these areas are ranked as they are. However, the SIMD is just one tool designed to help inform decisions and shouldn’t be used in isolation. 
Local knowledge of an area is particularly useful as this can reveal the underlying reasons for an area being identified as deprived by the SIMD.
Another useful source is the Scottish Neighbourhood Statistics website (www.sns.gov.uk). This provides a wider range of small area data than that used in the SIMD. It includes topics such as Community Care, Crime and Justice, Economic Activity, Education, Health, Housing, Physical Environment and Population.

Use of the SNS website is beyond the scope of this paper but the easiest way to get information for a datazone identified by SIMD is to enter the datazone code in the Area Profile option in the Standard Reporter (http://www.sns.gov.uk/Reports/ReportHome.aspx). 
4. Combining SIMD with other sources of data
Sometimes it can be useful to combine information on SIMD rank with other data, when this other data is available at datazone level. You or your organisation may have your own datasets at datazone level. Alternatively datazone-level data can be downloaded from the SNS (Scottish Neighbourhood Statistics) website (http://www.sns.gov.uk/). 

For example, we may want to look at the educational qualifications of people living in the most deprived areas of a local authority compared to those living in less deprived areas.
We can use the datazone code to attach the information about educational qualifications to our SIMD data and then use the methods described above to calculate qualification levels in (say) the most deprived local quintile compared to other, less deprived, areas. 
The example below does this for Fife local authority. Data on the number of pupils on the S4 roll, and the number of pupils achieving five or more awards at SCQF Level 5 or higher, can be downloaded from the SNS website. 
The chart below shows that in Fife local authority, the percentage of S4 pupils with 5+ awards at SCQF level 5+ increases as the local level of deprivation decreases (i.e. as local SIMD quintile increases).

Percentage of S4 pupils achieving 5+ awards at SCQF level 5+, by local deprivation quintile
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	How do I do that?

This is relatively simple to do (although perhaps not so easy to explain) and uses a handy formula in Excel.

First you should select the datazones associated with your chosen area (e.g. Fife) and copy them into a new spreadsheet. Then determine which datazones are in each local quintile, as demonstrated in section 3.1.3 above. 
For example, Fife consists of 453 datazones. Quintile 1 will therefore contain the 91 (453/5) most deprived datazones in Fife, quintile 2 will contain the next 91, etc. 
For this example we’ll call the spreadsheet containing this information ‘Spreadsheet 1’.

Place the data you wish to attach (e.g. educational qualification data) in a second spreadsheet (‘Spreadsheet 2’) with the datazone code in the first column and the data to be attached in subsequent columns (see screenshot).

Screenshot of Spreadsheet 2 containing Education data
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We can then use an Excel formula called ‘vlookup’ to match data in one spreadsheet with data in another spreadsheet. We can construct the vlookup formula to take a datazone code from Spreadsheet 1, find the information associated with this datazone code in Spreadsheet 2, and then insert this information in the appropriate row in Spreadsheet 1. 

The formula should look something like this. 

=vlookup(A2,‘[Book2]Sheet1’!$A:$C,2,FALSE)
· A2 is the cell containing the datazone code you want to match (e.g. S01002572)

· ‘[Book2]Sheet1’!$A:$C is the array of data containing the information you want to find (including the column with the datazone code) (i.e. columns A to C in Sheet1 of the spreadsheet called ‘Book2’)

· 2 is the number of the column in the data array containing the information you want to match. So, for example, in the ‘Book2’ spreadsheet, column 1 contains the datazone code, column 2 contains the values for ‘S4 pupils with 5+ awards at SCQFLevel 5+’, and column 3 contains the values for ‘School Roll’.

This is shown in the screenshot below.
Screenshot of Spreadsheet 1 – SIMD data with vlookup

[image: image17]
The formula can then be copied to all the rows in Spreadsheet 1. 
For this example we also need to calculate the percentage of the S4 roll who achieved 5+ awards at SCQF level 5+, so we also want to attach S4 roll data to Spreadsheet 1. This can again be done using vlookup, using the same formula as before except that this time the column number will be 3 for this dataset.

The screenshot below shows Spreadsheet 1 with the education and school roll data now attached to the SIMD data. 
Screenshot of amended Spreadsheet 1 – SIMD with education and school roll data attached
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Spreadsheet 1 now contains local SIMD quintiles along with the education data we wanted. For each local SIMD quintile we can now add up the number of S4 pupils who obtained 5+ awards at SCQF level 5+ and also the total number of pupils in the S4 roll. We can then calculate a percentage for each quintile and plot the results in a chart like the one above.




Worked example for Cree Valley
This example is taken from a presentation given to Dumfries & Galloway CPP on 5th February 2010 (http://www.scotland.gov.uk/Topics/Statistics/sns/SNSEve)

The map below shows the intermediate geography of Cree Valley in Dumfries & Galloway. This area is made up of 6 datazones, two of which are in Quintile 2 and the remainder in Quintile 3. 

Screenshot from interactive mapping website – Cree Valley’s SIMD quintiles and ranks
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We can use the background data available from the SIMD website to pull out data on the datazones that make up Cree Valley 
http://www.scotland.gov.uk/Topics/Statistics/SIMD/DataAnalysis/Background-Data-2012/Background2SIMD2012 
Screenshot of SIMD background data – Cree Valley datazones
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Dumiries & Galloway Dunifries & Galloway - Cracketfard and Carsphair
Dumiries & Galloway Dunifries & Galloway - Cracketfard and Carsphair

Castle Douglas
Castle Dougles
Castle Dougles
Wariaive.
Woriaive

338(501000914 170 Dumiries & Galloway Dunities & Gallsway - Dalbestie Delbeatti
933(501000925 170 Dumiries & Galloway Dunities & Galloway - Dalbestie Delbeattie
340/S01000931 170 Dumiries & Galloway Dunities & Galloway - Dalbestie Delbeattie
941(501000935 170 Dumiries & Galloway Dunities & Galloway - Dalbestie Delbeattie
342/501000939 170 Dumiries & Galloway Dunities & Galloway - Dalbestie Delbeattie
343(501000940 170 Dumiries & Galloway Dunities & Galloway - Dalbestie Delbeattie
344/501000943 170 Dumiries & Galloway Dunities & Galloway - Dalbestie Debeattic
945(S01001007 170 Duiries & Galloway Dunities & Galloway - Dunifies East Dumiries
946(501001012 170 Duiries & Galloway Dunities & Galloway - Dunities East Dumiries
947(501001015 170 Duiries & Galloway Dunities & Galloway - Dunities East Dumiries
345(501001018 170 Dumivies & Galloway Dunifies & Galloway - Dunities East Dumiries
343(501001021 170 Dumiries & Galloway Dunities & Galloway - Dunities East Dumiries
950/501001025 170 Duiries & Galloway Dunifies & Galloway - Dunities East Dumiries
951(S010009%0 170 Duiries & Galloway Dunities & Galloway - Dunifies South Dumiries
952(5010009%6 170 Duiries & Galloway Dunities & Galloway - Dunifies South Dumiries
953(501000999 170 Duivies & Galloway Dunifies & Galloway - Dunities South Dumiries
954[501001002 170 Duiries & Galloway Dunities & Galloway - Dunities South Dumiries
955(501001008 170 Duiries & Galloway Dunities & Galloway - Dunifies South Dumiries
956(501000952 170 Dumiries & Galloway Dunities & Gallsway - Dunities West Dumiries
957/501000983 170 Dumiries & Galloway Dunities & Gallsway - Dunities West Cargenbridge
958(501001024 170 Dumiries & Galloway Dunities & Gallsway - Dunities West Dumiries
953(S01001041 170 Dumiries & Galloway Dunities & Gallsway - Dunities West Dumfries
960/S01000908 170 Dumiries & Galloway Dumifies & Gellowsy - Flest Kirkcudbright
961(S01000913 170 Dumiries & Galloway Dumifies & Gelloway - Flest Gatehouse of Flest
962(S01000926 170 Dumiries & Galloway Dumifies & Gelloway - Flest Crestawn

963(S01000950 170 Dumiries & Galloway Dumifries & Gallowsy - Flest Gatehouse of Flest
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Best.it
Working Age
Population**

Total | (men1654, | Overall | Overall | Income
Population | women 1660 | SIMD2012 | SIMD 2012  |domain 201
(SAPE2010) | SAPE2010) | Score Rank | rate (%)

714 a2 1510 3593
740 438 1581 3445
a4 483 1403 3832
671 B 848 5011
£ 24 751 5304
e84 E 2358 2250
643 47 2612 1966
511 300 2585 1997
00 14 1853 3307
645 34 1580 3450
27 27 1837 3333
aa so7 1883 2,967
ass &75 1427 3184
asa 485 1476 3670
24 388 915 4923
a5 28 1983 2751
A am 2625 1140
a1s 500 2028 2697
755 12 1570 3461
&30 43 502 4955
601 74 738 5338
a8 25 273 1333
738 458 655 5541
600 B 22 2118
72 444 273 2,483
ass sa8 1810 3383
1413 655 1008 4122
a7 70 1883 2925
1071 610 1252 a3
‘840 433 554 5197
77 413 888 5028
&6 413 268 6405
1,008 25 1532 3543
13 436 1282 4109
1,805 1,008 1548 3504
538 25 865 5031
1,034 2 1183 433
73 35 13852 3920
a0 511 1918 2884
as6 451 1433 3758

iR SIMD 2012
ipaws s | auoshapess N N IO A A @& & -~ A-S
Ready

Te —

2

0
13
13

15
2
15

Humber of
Income
Deprived

People 2012

7

s

110

£

2

105

125

&

™
&
el
100
&
&
2
125
135
125
105
5
£
180
£l
110
110
110
8
&
100
2
an
2
&
&0
25
15
6
i
180
8

3538
302
3850
3256
4061
3828
6056
2198
1317
2351
2755
3916
4767
1768
5461
1852
2435
3163
431
3678
3308
6047
e
504
403
421
3268
6059
479
3895
21188
3696

s





Using this data we can create a chart which shows the domain ranks of each of these datazones (as described in section 3.7).
Chart: Cree Valley datazone ranks for each domain
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Amongst other things this shows that datazone S01000985 has a fairly low ranking in the Education domain. To access a wider range of contextual information it would then be possible to use SNS (http://www.sns.gov.uk/) to explore further.
Screenshot from SIMD mapping website – Datazone information tab for S01000985
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Once again, we can use the background data from the SIMD website to explore the Education domain in more detail (http://simd.scotland.gov.uk/publication-2012/download-simd-2012-data/). 
Screenshot of SIMD background data – Education domain
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Using the boxplot generator we can create the chart below (see section 3.5 for details). This shows the relative performance of datazone S01000985 compared to the Dumfries & Galloway local authority as a whole in each of the indicators that make up the Education domain. 
Ranking of datazone S01000985 in the Education domain relative to Dumfries & Galloway local authority. (Note that data for the indicator ‘Proportion of 17-21 year olds entering higher education’ has been suppressed for some datazones to avoid the risk of disclosure. When these datazones are selected for display as the datazone of interest on the boxplot, the green marker will appear as a zero value on the chart – but note that these are not real zeros.) 
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The boxplot shows that this datazone is performing relatively poorly in, for example, School Pupil Absences and Pupil Performance on SQA at Stage 4.
Similar analyses can be performed for other areas you may be interested in.
5. Contact details
If you have any questions about carrying out the analysis in this paper, please get in touch.
Name:

Catherine Dickie


Office of the Chief Statistician and Performance
E-mail: 
catherine.dickie@scotland.gsi.gov.uk
Tel:   

0131 244 7714
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